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CHAPTER

ONE

THE NSPEC® INSPECTION SYSTEM

1.1 Components

The nSpec® system hardware consists of an enhanced automated microscope, an optional nPLACE™ automatic wafer
loader, nCONTROL computer interface, and a computer.

1.2 User Interface

The nSpec system has three display windows - Stage View, Main View, and Camera View.

1.3 Menu Options

This section contains the functions of the menu options in each of the three windows.

1.3.1 Stage View Menus

File

• View Analysis Results - opens the Select Analysis dialog box and allows you to select and view an interactive
defect map.

• Open Image Set - opens the Select Scan dialog box and allows you to chose a scan a view an interactive mosaic
image.

• Save Mosaic - allows you to choose a destination and save a bmp, png or jpg file of the mosaic.

• Print - prints the current mosaic view.

• Print Preview - previews the page layout for printing the mosaic view.

• Print Setup - allows you to select print properties.

• Exit - nScan—closes the Stage and Camera windows.

Scan

• Job - opens the Select Job to Scan dialog box where you can choose to scan a “job” which is the name for saved
scanning parameters.

• Sample - opens the Scan Settings dialog box and enables you to set the scan parameters.

1
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Fig. 1.1: The nSpec System
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Fig. 1.2: nSpec Main Display

• Edit Last Scan’s ROI - allows you to edit the region of interest (ROI) that was identified in the previous scan.

• Edit Predictive Focus Patterns - opens the Predictive focus point definition dialog box where you can create
or edit a predictive focus pattern that uses sample points you select for predicting the various height settings for
the objective during the scan.

• Create Device Layout - opens the Create Device Layout dialog box and allows you to set up a Device Inspection
layout.

• Device Inspection Alignment - opens the alignment wizard that guides you through device inspection setup.

Stage

• Set autoloader parking position - opens the Autoloader Parking Position dialog box and allows you to set the
stage height for wafer transfer when using the nPlace™ wafer loader.

• Turn on Chuck Vacuum - applies vacuum to the chuck. This is only available if an autoloader is connected to
the system.

• Autoloader Manual Control - opens the Autoloader Manual Control dialog box and allows you to control
autoloader settings.

• Initialize Stage - allows you to reinitialize the stage without restarting the software.

• All Stop - prevents stage movement when using the AFM scanning probe.

View

• Grid - clicking this will show or hide the grid lines on the stage view.

• Last scan mosaic - allows you to view the mosaic image from the last scan mapped on the stage grid. To enable
this view, Click > Entire Stage View. This will enable the Last scan mosaic viewing option.

1.3. Menu Options 3
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• Highlight Regions of Interest - show or hide the regions of interest

• Entire stage view - view the entire stage.

• Last scan view - view the last scanned image.

• Last image set view - view the last scanned image set.

• Adjust image set threshold - opens the Thresholding dialog box where you can adjust the pixel intensity
threshold. A broader range between the value defined as black and the value defined as white has greater
contrast.

• Properties - opens the Stage View Options dialog box where you can set grid and line colors.

Calibrate

• 2.5x, 5x, 10x, 20x, 50x - opens the Calibrate Objective dialog box where the calibration objections for each
objective can be set. This is configurable and is based on the objectives that are included. AFM (atomic-force
microscopy) can also be included.

• Calibrate Turret - opens the Turret Calibration wizard where you can calibrate the position of each objective.

• Calibrate Illuminator - enables calibration of the automated Illuminator that switches between light modes.

• Calibrate Autoloader - enables calibration of the nPlace™ automatic wafer loader.

• Calibrate Autofocus - opens the Automatic Focus Area dialog box where diameter, offset, and F-stop control
can be set.

• Calibrate Light - opens the LED Calibration dialog box where the average pixel intensity level can be set.

• Calibrate Vignetting - accesses vignetting algorithm and calibrates the system to compensate for vignetting.

Autofocus

• Autofocus - opens the Autofocus Settings dialog box

Objective

• 2.5x, 5x, 10x, 20x, 50x - objective selection. This is customizable depending on the installed objectives.

• Home - rotates the turret to the Home position.

• Define Objectives - opens the Select Objectives dialog box where you can order the installed objectives and set
the default objective.

lluminator

• Bright Field - Bright Field illumination.

• Dark Field - Dark Field illumination.

• DIC - Differential Interference Contrast (Normarski Microscopy).

• Home - rotate the illuminator to the Home position.

4 Chapter 1. The nSpec® InSpection System
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Options

• Options - opens the Program Options dialog box where system settings can be edited.

Utility

• Exercise Stage - used by service for stage diagnostics.

• Parametric Movement - allows you to input numerical stage positions and stage angles and set the camera
angle.

• Pattern Editor - create and manage custom scan patterns and regions of interest (ROI).

• Looping Scans - repeat a single scan (normally used for repeatability and longevity testing)

SECS/GEM

• GEM Interface - connects to a SECS/GEM system.

• Edit Startup - configure the startup options.

• Connection Status - view the connection status.

• Enable - enable SECS/GEM if it is disabled.

• Local Control - enables local control only.

• Remote Control - enables the Host machine to control the system.

• Enabled {not communicating} - shown when Host is offline.

• Online (remote) 0 shown when remote system is connected.

• Listening

• Terminal Services

• Debug

Help

• About nScan - Display version information.

1.3.2 Main View Menus

File

• Launch nScan - opens Camera and Stage View windows, if closed, and re-initializes the system.

• Open Image Set - view the mosaic image of a scanned sample.

• Exit - exit the nSpec software.

1.3. Menu Options 5
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Analysis

• View Results - view the results of a previous analysis.

• Export - export analysis data from nSpec in various file formats.

• Import - import Surveyor images.

• Edit Analysis Group - make edits to an analysis group.

• Edit Parameters - edit the parameter settings for a selected analyzer.

• Analyze Images - analyze images from a completed scan.

Options

• Program Options - opens the Program Options dialog box where you can change system defaults.

Utility

• Golden Die Utility - used to create golden templates for use with Device Inspection.

• Back Up ProgramData - back up the program data.

• Insert Exception Log Note - add a note to the log file.

User

• Log-over — change to a different user level.

Window

• Auto Save Positions on Exit - saves the window positions on exit.

• Save Positions - saves the current window positions.

• Save Positions (Sheltered) - saves the window positions for use in Sheltered Mode.

Help

• About nScan - Display version information.

1.3.3 Camera View Menus

File

• Save Image As - save a live image as a bmp, png, or jpg file.

• Save Selection as Image - save a selected section as a bmp, png, or jpg file.

• Interval Save Image - set a time interval for automatic capture and save.

• Page Setup - set up page orientation, size, and margins for printing.

• Print - print the current image.

6 Chapter 1. The nSpec® InSpection System
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• Print Preview - preview current image prior to printing. Exit nScan—closes the Stage and Camera View
windows.

Camera

• Open - re-initializes the camera.

• Imaging Settings - opens the Imaging Settings dialog box where you can make changes to illumination type,
auto and manual focus, exposure, LED light control, and threshold.

• White Balance - for color cameras, performs automatic white balance.

• Set Exposure Time - actuates the Program Option changes made to exposure time.

• Reset Camera - resets the camera.

Objective

• 2.5x, 5x, 10x, 20x, 50x - select objectives (based on the installed hardware).

• Define Objectives - opens the Select Objectives dialog box where you can order the installed objectives and set
the default objective.

View

• Pseudo-Color - view live images in monochrome red, green, or blue.

• Scale Bar - turns on a scale bar for image measurement.

• Adjust Threshold - opens the Thresholding dialog box where you can adjust the pixel intensity threshold. A
broader range between the value defined as black and the value defined as white has greater contrast.

• Auto-focus - Area—displays autofocus red circle

• Negative Image - enable or disable negative image view.

• Alignment Lines - displays the cross hairs for alignment.

• Light Intensity Variations - view quadrant and average light intensity values.

• Properties - change alignment line color and width, change border and measuring border colors.

1.3. Menu Options 7
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CHAPTER

TWO

FOCUSING AND LIGHTING

The nSpec has several focusing and lighting options available. This section will guide you through using manual
focus, selecting autofocus options from the Autofocus Settings dialog box, and using the lighting techniques.

2.1 Manual Focus

The user can manually adjust the height of the sample to bring it into focus. This can be done through the graphical
user interface or using the joystick. Note, for unpatterned samples it can be helpful to close the F-stop using the
Imaging Settings dialog to provide a clear boundary on which to focus.

Fig. 2.1: Joystick focus control
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Fig. 2.2: Imaging Settings
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2.2 Autofocus

nSpec has the capability of automatically focusing using an algorithm based on the detected contrast in an image.

Note: Making changes to Autofocus Settings requires Admin login privileges.

2.2.1 Calibrate Autofocus Area

When focusing on samples which do not have large amounts of inherent contrast, the F-stop is used to project an image
onto the sample for the purposes of focus. In this scenario, focus is greatly improved by having the focus algorithm
work only on the region around the edges of the F-stop projection. Calibration of the Autofocus Area should only
need to happen once - it does not change with objectives or samples.

1. Place the sample on the stage and move to a position in the region of interest.

2. From the Stage View select Calibrate Autofocus from the Calibrate drop-down menu.

3. Close the F-stop.

4. Focus using the joystick control until the edges of the field diaphragm appear to have the highest contrast. (Note,
if the joystick is unavailable Imaging Settings can be used to control focus through the GUI.)

5. Modify the ring pattern such that it overlaps the entire F-stop boundary. The software uses this area to determine
the focal distance with maximum contrast. The horizontal and vertical positions of the ring can be changed,
along with the inner and outer diameters. Adjust the ring such that it covers the entire boundary (inside and
outside edges) of the F-stop.

2.2.2 Establishing Autofocus Parameters

Autofocus settings are stored in Autofocus parameter groups to make it convenient for storing settings for use in scan
jobs. Each group can be named for easy recognition. Note that for ideal operation a focus parameter group will be
made for every objective / sample combination. A typical process for establishing autofocus settings would proceed
as follows:

1. Establish good focus either through manual focus or an untuned use of autofocus (may take longer than desired
or not achieve perfect focus).

2. Open the Autofocus Settings Dialog, Autofocus > Settings.

3. Click Save As and specify a new name and, optionally, a description. As the number of autofocus parameter
groups can be large, remember to be as specific as possible.

4. Set Autofocus Type as desired for the intended scans. Note this setting only applies to how autofocus is used
during a scan, and will not impact its behavior in the Imaging Settings dialog. Settings can be:

(a) None - No autofocus is preformed. Note, the ability to not perform autofocus is also present in the scan
dialog.

(b) Manual Predictive - At scan initiation, the stage will traverse through the focus pattern and wait for the
operator to manually focus at each point.

(c) Automatic Predictive - At scan initiation, the stage will traverse through the focus pattern and conduct an
autofocus at each point.

(d) Contrast Focus Every Tile - The scan will perform an autofocus before acquiring every image that is part
of the scan.

2.2. Autofocus 11
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For most scans, Automatic Predictive will be the correct setting.

5. Establish the Initial Offset for the scan by achieving a good focus using the sample and objective to be used
in the scan, and clicking the Set Autofocus Offset button at the bottom of the screen. This will set the Initial
Offset parameter (inside the Contrast Algorithm subsection) to a Z position above the current focus point. This
ensures that we approach the focus point from the top at a height appropriate for the current objective and
sample.

6. Click Save and close the dialog box.

Other parameters of interest:

• Timeout - may need to be increased for particularly difficult samples.

• Change Significance Factor - sets the percentage decrease that must occur to determine that we have reached
the maximum contrast. Note that an absolute comparison is not appropriate as statistical differences between
out of focus images and noise can cause small fluctuations in contrast. However, a setting at too high a threshold
will cause the algorithm to miss a legitimate contrast maximum.

• Bottom Up Search - perform the search starting from below the sample. Useful for instances in which we want
to focus on the bottom of the substrate in a transparent sample.

• Z Correction - In some rare cases analysis performs best in an image which is slightly out of focus or there is a
desire to focus at a point above or below the point of maximum contrast.

2.3 Illumination Types

There are three illumination types available:

• Bright field is an illumination mode in which light is projected vertically onto a sample, then reflected vertically
into the objective. This illumination mode generates data that is linearly related to the actual size of the sample
being viewed. Bright Field the most suitable illumination mode for taking size measurements.

• Darkfield is an illumination mode in which light is projected obliquely onto a sample, then reflected vertically
into the objective. The oblique lighting used in Darkfield acts as a high-pass filter. Data acquired with Dark
Field illumination contains information that is too small to see in Bright Field. Dark Field is most suitable for
detecting very small features.

• DIC (Differential Interference Contrast) also known as Nomarski Microscopy is an illumination mode that uses
orthogonally polarized mutually coherent lighting to amplify optical path length information. This illumina-
tion mode generates images similar to phase contrast microscopy. DIC is useful in visualizing 3-Dimensional
information that is not typically visible in Bright Field or Dark Field illumination.

12 Chapter 2. Focusing and Lighting



CHAPTER

THREE

PERFORMING A SCAN

The overall process for establishing a scan for an unpatterned wafer or to scan a specific pattern (region of interest) is
as follows:

1. Configure Autofocus as appropriate for the scan. See Establishing Autofocus Parameters (page 11)

2. Create an Autofocus Pattern if an appropriate one does not exist.

3. Establish light intensity.

4. If performing a Device Inspection scan,

(a) Create an Alignment

(b) Create a Layout which specifies the device positions, sizes, and names.

5. Complete Scan Settings dialog and initiate scan.

3.1 Establishing light intensity

3.2 Initiating the Scan

1. On the scan dialog, there are three ways to set the scan ID.

(a) Enter a new sample ID. The field may contain letters, numbers and/or spaces. Do not use symbols for the
sample ID.

(b) Use an existing sample ID. Click the . . . button after the Sample ID box, and choose Recent Sample ID.
Select the desired ID from the list.

(c) Enter a list of sample IDs for use with an automatic wafer loader. Click the . . . button after the Sample
ID box, and choose Sample ID List. Enter the list of ID values. The list can be entered directly into the
Sample ID box by separating the IDs with commas.

2. To select a scan directory that is not the default scan directory, click the . . . button after the Sample ID box and
choose Select Scan Folder. Find or create the folder where the scan data will be stored.

3. Select an objective from the drop-down menu. Be sure to rotate the nose-piece manually to the correct objective
if the system is not equipped with a motorized nose-piece. When manually rotating the nose-piece, be sure the
objective is in the detent. The objective will click into place.

4. Select the desired Autofocus Parameter Group (See Establishing Autofocus Parameters (page 11)) and if focus
prediction is enabled, the appropriate Focus Points pattern.

5. Select the desired type of scan in the Pattern section. Available types of scans:

13
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• Wafer - Scans the entire wafer. Select the diameter of the wafer, scan percentage, and offset (adjusts for
the specific positions).

• User Defined - Scan a pattern as created in the Pattern Editor.

• Devices - Device Inspection scan. See <Device Inspection> for overview and required files.

• Defects - Take images of defects from a KLARF file generated in a previous scan or an external tool.

6. Select the analysis to be completed. (Note, analysis is not available for Defects scans. There are currently 5
main analyzers available:

• Basic Selection (Contrast, Morphological Range)

• Basic Selection (Intensity, Exclusive)

• Basic Selection (Intensity, Inclusive)

• Device Inspection - requires a scan of type Defects

• Die Yield

Configure parameters for the analysis by clicking the . . . button.

7. Select the illumination type and intensity setting.

8. Select the autoloader settings if the autoloader is to be used.

9. Save as a new job using Save As from the . . . button. It is also possible to load an old job for running and/or
modification using the job dropdown.

10. Click OK to start the scan.

A window will open showing the progress of the scan. The mosaic image of the scan will start to build on the Stage
View window, and a live image will appear in real time as each tile is scanned in the Camera View window.

Once the scan is complete, the progress window will close and a full mosaic image will be displayed in the Stage View
window until another scan is initiated or the window is closed.

A database file (.db) and an image file folder will be created in the Scans directory for each scan named with the
specified sample ID (e.g., for Sample ID “X001,” a database file (X001.db) and a directory (ScansX001) will be
created). The database file and image folder pair should always be saved and stored together so that the images can be
recalled or analyzed at any time in the future.

Upon completion of the scan, the selected post-scan analysis will be initiated and an Analysis Progress Window will
open.

The two checkboxes in the lower left corner of the dialog window control the post-analysis behavior. They can be
toggled at any time during the analysis. The default condition for these checkboxes can be set with the Analysis
Progress Window section of Program Options.

3.3 Wafer Scan Offsets

For scans of type Wafer, Offsets define the position of the scan on the stage starting from the bottom right corner.
Offsets can be set manually by entering values in the dialog box accessed by clicking the . . . button to the right of the
offset selection in the Scan Sample dialog. Note, offsets are in microns and must be negative to indicate the distance
from the bottom right corner.

Alternately the offset can be calculated using the offset tool:

1. Scan the wafer without modifying the offset.
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2. In the Stage View select View > Entire stage view and then View > Last scan mosaic. An image showing the
area scanned will be shown on the grid.

3. Drag the scan area to the desired position.

4. Right click on the grid and select “Save Pattern Offsets”. Enter a new name or replace a previous name as
desired.

Fig. 3.1: Saving the Pattern Offset
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3.4 Pattern Editor

The Pattern Editor enables the creation of custom scan patterns. There are drawing tools to create an ellipse, a
rectangle, a square, or you can draw a scan pattern with the drawing tool. To open the Pattern Editor, from the Stage
View, Utility > Pattern Editor. There the tools work much as would be expected in a drawing program. Context
sensitive help is available at the bottom of the screen for tool specifics. Note that to erase individual tiles, use a Right
Click with the Draw tool selected.

The eye icon, toggles a mode for Regions of Interest. In this mode rectangles can be created, using the standard
Rectangle tool, over specific areas of the pattern for subsequent use. Focus points can be added within the region of
interest as well.

TBD - Additional discussion of focus algorithms and use of Regions of Interest.

3.5 Running a Job

Scans which have been previously configured in the Scan > Sample dialog and saved as a Job can be subsequently
run by using the Scan > Job dialog. Upon picking the job to be run, and clicking OK, the scan settings dialog is
presented, allowing for a new wafer ID to be entered.

3.6 Device Inspection Alignment

When performing a device inspection scan, the first step is to create an alignment. The alignment process uses com-
puter vision to detect features on the sample, rotates the camera to align, and modifies the stage movement such that
the stage coordinate system corresponds to the detected points. The alignment process is run by selecting Scan >>
Device Inspection Alignment >> Start Wizard on the stage view and following the prompts. The wizard will walk
you through the selection of three points:

• North and South Alignment Points - define stage rotation

• Origin - used as the reference point for device positions. Note when KLARF output is desired, the Origin should
be selected as the bottom left corner of the 0,0 device.

There are two methods that can be used for the alignment point search. The selection of which method is done through
Program Options and applies to all scans.

• Template Matching - attempt to find the image acquired during alignment setup in the actual sample. For this
method select a small area with the bounding box which contains a unique, clearly identifiable feature.

• Feature Detection - look for key points (borders, corners, etc.) in the sample which match the pattern of features
in the alignment image. Feature Detection works best with a relatively large area (50% to 75% of the image)
with many features.

When complete, the alignment process will save a CSV file with the position data and images of the three points.

3.7 Device Inspection Layout

The Device Inspection Layout specifies the devices to be scanned and includes information on device position, size,
and names. The Device Inspection Layout dialog is accessed on the Stage Window through Scan >> Create De-
vice Layout. The first step is to run the appropriate alignment with the sample on the stage (See Device Inspection
Alignment (page 16)). The actual layout can then be created either through using the GUI to extrapolate data or by
manipulating existing layout information into the nSpec format.
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3.7.1 Layout Creation GUI

After completing the alignment,

1. Enter the device size in PitchX,PitchY and Width,Height. Normally these values should be the same and can be
either obtained from existing layout information or measured by moving the stage to the diagonally across one
or more devices and recording the distance between the same point on the devices. Note that measuring across
multiple devices and dividing by the number of devices should produce more accurate results.

2. Enter the desired number of rows and columns. Devices information will be created for a rectangle of devices
of the specified size.

3. Position the stage at the top left corner of the top left device of the desired region.

4. Click Extrapolate

5. Verify that the layout points are correct by checking that the red points on the stage view are located at the top
left corner of the desired devices.

6. Repeat steps 2-5 as often as required to complete the layout.

7. Optionally device names can be added by clicking Name Device.

8. Save the device information by clicking Export Device Layout.

Note, don’t be alarmed if you accidentally close the window. When the Layout dialog is launched again it will retain
the work in progress.

3.7.2 Creating Layouts from Existing Data

Often layout information is already available and it is easier to modify it than to execute the manual creation process
described in Layout Creation GUI (page 17). Any method of doing the modification will suffice as long as the result
is a layout file with information which matches the required format:

Version 1
DiePitchX 875.0000
DiePitchY 960.0000
BeginDelimitedListing
Id,X,Y,Xindex,Yindex,W,H,Name
1,0,-960,0,0,875,960,DeviceA
2,0,0,0,-1,875,960,DeviceB

In this example, the layout contains two devices, the origin device (at row,col 0,0) named “DeviceA”, and the device
directly below it (0,-1), “Device B”. The device size is 875𝜇m (width) by 960𝜇m (height).

nSpec is capable of scanning devices placed at any locations, but if valid KLARF exports are desired, the layout must
conform to KLARF specifications. With KLARF, devices are on a grid with cells of “Pitch” size. All devices must be
on the grid, and the origin device is defined as row, col 0,0. Note that KLARF defines devices by the bottom left corner,
while nSpec specifies devices by the top left. Thus, the 0,0 device shown above has a Y value of -960, reflecting the
use of the top left corner.

Also note that the nSpec stage coordinate system defines the 0,0 stage coordinate as the top left corner of the stage.
Thus moving down and right are positive coordinate movements. Moving up and left are negative. This corresponds
with common practice in image processing (where images are defined by their top left corner), but can be confusing
when thinking of normal graph paper coordinates. KLARF uses the normal graph paper system (moving up is positive
Y).

3.7. Device Inspection Layout 17
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3.8 Device Inspection Modes

Device Inspection can operate in one of two modes, which affect the process for both scanning and analysis. Which
mode to use is set through the Job Property variable UseDIClassic. Normally the mode should not need to be
changed.

3.8.1 Device Inspection Classic

UseDIClassic to true

In Device Inspection Classic, the wafer is scanned in a grid pattern, where any image which covers the devices
in the layout is taken. Image acquisition does not take into account the position of devices within the image. At
analysis time, the devices are reconstructed from any images in which they appear and analysis is performed. Device
Inspection Classic has the advantage of using fewer images than Golden Tile Scanning, but can have issues with
stitching, particularly with devices without clear features that can be used for alignment within the device. And, if
only a small sliver of a device is in the image field, it can be misaligned (not enough information for proper alignment).
And, any remaining optical abberration or vignetting will impact the quality of analysis as the effects will happen in
different places on each device.

Device Inspection Classic is being phased out and will likely be completely replaced by Goldent Tile Scanning in
future releases.

3.8.2 Golden Tile Scanning

Default ( or UseDIClassic to false ).

Golden Tile Scanning works by proceeding in an identical path over each device. Thus tile one in a device is always
its top left corner, and every tile can be compared directly to the same tile in other devices. This method eliminates the
need for stitching and mitigates the effect of optical abberration and vignetting.

When using Golden Tile Scanning with small devices (less than one image tile), as many devices as fit evenly (without
overlapping the image edge) are considered part of the Tile and are analyzed using the same, single image. In this
case, more images will be required than in Device Inspection classic, as the edges of the image with partial tiles are
not used for analysis, but the quality of analysis should be significantly better.
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CHAPTER

FOUR

ANALYSIS

Once a scan has been completed the acquired images can be analyzed. Analyzers can be launched automatically upon
scan completion, if configured in the job, or manually through Analysis > Analyze Images on the Main View window.

4.1 Manually Launching Analysis

When manually initiating analysis, the correct scan must be selected. The Select Analysis dialog defaults to the most
recent scan. If a different scan is desired, it can be retrieved by

1. Selecting the appropriate folder.

2. Selecting the database to be used. Note, database names are set to the SampleID from the scan dialog.

3. Selecting the specific scan from the dropdown.

At this point the specific analysis to be run and parameters to be used can be set. In cases where multiple analysis runs
are needed, an Analysis Group can be used. It will package together multiple analysis runs that will execute on the
same scan and display their results together.

4.2 Basic Selection Analysis

4.3 Die Yield

4.4 Device Inspection

Device Inspection Analysis has two main components, (1) generating a template, and (2) using the template to perform
analysis.

4.4.1 Device Inspection Templates

Device Inspection creates a statistical model for what a perfect device (the “template”) should look like and how much
variation we should expect when examining additional instances (the amount of process variation in the sample and
statistical variations in image acquisition). This is controlled by the parameter Generate Golden Template. It can be
set as follows. Each setting relies on the field, Golden Template which species where the template is stored.

• Create New - create a new template. If a template exists at the location specified with the same name it will be
overwritten.
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• Add to Existing - add the statistical information from this sample to the existing template. This can better
incorporate variations between wafers into the template.

• Do not Update Template - only perform analysis.

4.4.2 Device Inspection Parameters

• Advanced Optional Custom Analysis Flags

– lfa - Low Frequency Highlight Analysis. Perform analysis using a version of the template and image which
have had high frequency features removed. This allows the detection of features which cover an area of
smaller features.

– ec 0 - Error Correction Disabled. Typically template generation eliminates outlier data. This allows the cre-
ation of high quality templates with even very low numbers of input devices with many defects. However,
in instances where the amount of process variation is very high, the outlier elimination can erroneously
exclude actual process variation information. This will result in it being difficult to find defects without
also getting large numbers of false positives. This setting turns off error correction, thus using all input
data for the template.

– hft - High frequency template. In some samples with very high frequency features, the image matching
process can have difficulty aligning correctly. This feature provides for a different method of aligning in
these specific cases.

• Defect Eccentricity - eliminate defects which have odd shapes. This can be helpful in removing false positives
which occur on the edge of features or images.

• Defect Sensitivity - Sigma Disparity - How many standard deviations from the template must a feature be
before it is identified as a defect.

• Max Defect Merge Distance - combine defects into a single object.

• Defect Area - limits the defects reported by area.

• Optional: GTS Device Numbers to Analyze - Can restrict analysis to a subset of the devices in a scan. This
can be useful for testing or applying different parameters to different areas.

• Padding (Pixels) - How far should we allow the computer vision algorithm to move the acquired image to match
the template. This compensates for differences in actual device placement and differences between the stage
movement and layout information.

• Sigma Bloat Factor - Expands the Sigma Signal into neighboring pixels. Typically has the effect of reducing
false positives around feature boundaries. Lower values are a more correct analysis, though more prone to error.

• Sigma Safety Factor - Amplifies the Sigma Signal around feature edges to reduce risk of picking up false
positives on/around them. (typically see best results when set higher than 1)

4.5 Golden_Die_Utility

4.6 AI Analyzer
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FIVE

VIEWING ANALYSIS RESULTS

If you checked the Display results when complete check box, the analysis report will open automatically. If not, using
the Main View window, click Analysis > View Results and select the appropriate results by selecting the Folder,
Database, Scan, Analysis Type, and the specific Analysis.

Fig. 5.1: Defect Report

On the right of the report are the Bin Table, Report Details, Analysis Details and Analysis Parameters.

The Bin Table provides a color-coded legend for defect bin sizes.

Clicking on an image opens that image in a window. Additionally several images can be displayed together by clicking
and dragging across a region. Once an image is displayed, defect annotations can be turned on and off by using View
> Annotations or with the shortcut Ctrl+Shift+A.
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If a single image is displayed, the arrow keys support navigating through the entire set of images.

• Arrow Key - move to the next tile with a defect in that direction. This allows a quick review of all found defects.

• Shift + Arrow Key - move to the next tile in the direction, regardless of whether it has a defect.

In either case, if the edge of the tested region is encountered, loop onto the next row or column.

5.1 Changing Bins for Defect Count and Size Reports

The bin values for defect count and size reports can be modified. Right click anywhere on the report and select
Properties. From this dialog there are options to add bins, remove bins, modify bin values, and set colors.

5.2 nView Display Options

The View menu provides options to select:

• Report to view, binning defects by Count, Size, or showing a Size Histogram.

• Whether defects should be displayed and various screen items

5.3 nViewMulti
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SIX

EXPORTS

6.1 Manual exports

The nSpec® Main View window, Analysis > Export menu provides the ability to:

• Export Scan to CSV - Scan data (times, image location, field of view size, image file names, scan parameters,
etc.)

• Export Analysis to CSV - detailed information about the defects detected with basic analyzers

• Export Histogram to CSV - defect data in a format suitable for creating histograms

• Export Device Inspection to CSV - device inspection defect information

• Export Analysis to XML - XML formatted defect information

• Export Analysis to KLARF - For device inspection scans, export a defect report in KLARF format.

• Export Surface Roughness to CSV - Deprecated

• Export Crack Failure Analysis to XML - Deprecated

• Export Images to Surveyor - Deprecated

For any export, select an image database and then click Open to display the Select Analysis dialog window.

The Select Analysis dialog window is used to choose the scan containing the analysis of interest. If more than one
scan has been run under the same sample ID, the scan can be selected from the Scan drop-down list. The scans in the
list are organized by date and time.

The Scans section of the dialog window describes the current state of the scan as Success, Aborted or In Process and
displays the number of image tiles for the scan. The most recent scan is the default displayed.

Once the scan is selected, click the Analysis drop-down list to select the specific analysis result to export. The Analysis
results in the list are organized by date and time. The analysis dialog also describes the current state of the analysis as
Complete, Aborted or Scheduled and displays the total number of defects found during analysis.

The default file name will be the sample ID name. Click Save and that .csv will be saved in the scan Analysis directory
unless another file path is chosen.

6.2 Automatic Exports

Analysis data results can be exported automatically by turning on the feature in Program Options. Select the Options
dropdown menu from any of the main nSpec windows (Main View, Stage View, Camera View) and expand the sub-
heading Reporting Export. Set Automatic to 1, and then set the remaining options based on the desired report type
(CSV, XML).
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SEVEN

MACRO INSPECTION

7.1 Running a Macro Scan

Running a scan with Macro Inspection is the same as running any other job, but three new job fields on the Scan
Settings dialog must be considered:

• Macro Scan Type - determines whether Macro Scans should be run and whether it should be run stand-alone
or in combination with a full nSpec scan.

• Run Aligner - when checked the aligner will run during macro only operations. This setting does not affect
operations that include a full nSpec scan.

• Macro Configuration - location of the macro configuration file to use.
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EIGHT

AI ANALYZER

8.1 Definitions

• Dataset Represents a scan of a wafer. A collection of tile images.

• Tile One image in a dataset.

• Label A marker added by the user to a tile image to mark defective locations. These are intended to be the base
truth. Outputs of the inspector are compared automatically to these labels to assess quality.

• Defect A marker added by the inspector over what it deems a tile defect. Defects are the final output of the
silicon inspector.

• Inspection One sweep of a tile or dataset by the inspector.

• Pipeline A sequence of steps that carry out an inspection. The user must train the detection and classification
steps before the inspector can function. The most important parts of a pipeline are:

– Detector Spots and records abnormalities in a tile image and sends them to the classifier for further
inspection.

– Classifier Refines and then classifies the detector’s findings by defect type.

• Mosaic The map on the top left of the image page that displays the user’s location on the dataset and the location
of all the tiles that have been labeled.

8.2 Setup and Running

After any software update, open the base directory where the inspector is installed and click setup.bat.

Click silicon_inspector.bat to run and log in by choosing a username and clicking the key button. You will be greeted
by the initial interface:

8.3 Load Data and Add Settings

The silicon inspector needs data and settings before it can inspect silicon datasets, labels, and a pipeline. Let’s start
by giving it a dataset. To load a dataset, click “Import”, a link located next to CHOOSE DATASET on the top left.
NOTE: The select folder window will most likely not be in the foreground. In that case look for the flashing window
on the taskbar at the bottom of the screen.

Navigate to the folder containing the dataset you would like to load (a sample set has been included in the Scans
folder). Ensure that it has a corresponding database file they are formatted as [dataset name].db and then click select
folder . Make sure the database file is present, otherwise the import will not work correctly.

27



nSpec® User Manual, Release 0.9

Fig. 8.1: AI Analyzer initial screen

Next we’ll add a pipeline. Click the IMPORT link next to CHOOSE PIPELINE on the right. Follow the same
procedure we used above locate the pipelines folder, select a desired pipeline then click select folder. When the system
is first set up no pipelines will be present, but a default base pipeline is included in the Pipelines folder.

Now that we have the default base_pipeline let’s branch a new pipeline off. Click COPY. A form will pop up in the
center of the screen prompting us to name the copy. Enter one and click OK. The copy will appear on the list. To
delete pipelines click the x to the right of that pipeline.

Now that we have a dataset to analyze and pipelines to train we can start training. Click the Go To Training button on
the top right. This will bring us to the dataset page.

If the dataset we are inspecting was previously labeled we should load its labelset now. Click the load Import Labels
button located in the rightmost column above the Run Pipeline button. Navigate to the folder containing the previously
exported label database and click Select Folder. The defects table on the bottom left will now be populated with all
defects present in the imported labelset. If any defect types already existed in the inspector, they will be merged.
Important Note: Make sure all defect type names are coordinated. This is the only method for correctly merging
defects of the same type. New defect types can be added by typing a defect name in the “Add Defect Type” form,
choosing a color and clicking the plus button. We’ll go over this later.

Finally, we can label and train a pipeline. Click any tile (image) on the dataset mosaic.

8.4 Training the detector

Welcome to the tile page. There’s a lot to take in but we’ll go over all the functionality slowly. Let’s start by adjusting
the size of the tile image in the center column using the zoom in and out buttons. They’re in the right column at the
top, the plus and minus. Keep scaling the image until it is properly in view. Now that the image is in view it has
become clear that there are no defects on this tile to label. So let’s move on to the next tile. The right arrow button in
the center of the header (top) will mark this tile as visited and bring us to the next tile that has not been visited. Let’s
click it.
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Fig. 8.2: Creating a copy of a pipeline

Fig. 8.3: Dataset page
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Fig. 8.4: Training

Note how the navigation mosaic on the bottom left has changed. The tile we just visited is now blue. We can visit that
tile, or any other tile for that matter, by clicking it on the navigation mosaic. Give it a try.

It’s time to label the image. Click the button in the right column with the circle icon. It’s next to the cursor icon. We’re
now in labeling mode using the circle tool.

We can now add labels by double clicking on the image. To change the label class from “Other” to basic selection,
downfall, octopus, etc. . . select the desired type by clicking on it in the left and then click on a defect type in the table
on the left. To add a sequence of labels of one type deselect all the labels, then click on a label type in the table. All
subsequent labels will be that type. To re-size the labels use the mouse’s scroll wheel. To move the labels drag them
with the mouse or arrow keys. To re-size along the x or y axis alone, combine the shift key with the right or up arrow
key. For convenience, here is a list of labeling commands/hotkeys.

Labeling controls:

• Re-size

– Scroll wheel

– i, o, or p keys

– Shift + [Arrow Key]

• Shift location on tile

– Drag with mouse

– [Arrow key]

• Change label type

– [Number key]

– Click label type in table on left
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– Scroll through label types with b or n keys.

• Delete

– d key

Place a label over the the octopus in the center of the tile like this:

Fig. 8.5: Labeling a defect

Now Let’s look below the mosaic at the pipelines table. Each row of the table houses a different pipeline; we’ll focus
on the row that contains the pipeline we created earlier, new_pipelinecopy_of_base. I think we are both excited to run
this pipeline so Let’s give it a try. Go ahead, press the eyeball next to new_pipelinecopyofbase.

Wow, that’s terrible. It totally missed that octopus.

It seems untrained pipelines perform poorly, so Let’s train it on our labels and try again. To train on this tile click the
arrow next to new_pipeline, which drop a training menu.

Ensure that Detector is selected in the dropdown above Create Transformations, then click Create Transformations,
which will turn green until the process is complete. Don’t click any buttons until the transformations button returns to
its original gray color. Then click the Train Pipeline button to train the detector. If any process continues for more
than a second it likely prints command line output, so if it seems like a process is taking too long check the command
line.

Now Let’s see how we do.

Wow, look at that. It detected a defect we didn’t even label. Let’s go ahead and add those missing defects to the
labelset.

To train the best detector, choose tiles that best represent the overall dataset. The chosen tiles should not be edge tiles
unless the dataset is all edges and should contain examples of every type of defect found in the dataset. For example,
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Fig. 8.6: Miss

Fig. 8.7: Training output
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if we trained a detector on the first tile below, which features only octopi, and then ran it on the second tile, which has
a carrot and a basic selection.

This detector missed the basic selection on the right tile. Repeat this process until the detector functions well across
several tiles, then return to the dataset page and run it across your entire dataset.

Return to the dataset page by clicking the G icon at the far left of the header. Once there, click the eye icon next to our
new pipeline and then click Run Pipeline. It should turn green and run the inspector on all of the tiles in the dataset,
as shown above. When the inspection is complete look at the results bar. The only statistics that we care about for now
are misses % and complete misses %. If the pipeline performs well we can move on and train the classifier. Otherwise
we must continue training the detector or train the detector on new, more representative samples. It is important to
have the best detector possible before training the classifier.

8.5 Training the classifier

Training the classifier is nearly indistinguishable from training the detector but usually requires more training data,
depending on the size of the dataset. To train the detector we labeled one, maybe two tiles and then trained. To train
the classifier we will add five hundred to one thousand labels. So let’s get going!

Whew, that was a lot of clicking. It’s finally time to generate examples and train the classifier. Let’s return to the
pipeline page (we accessed it before from the dataset page).

We can train the classifier the same way we trained the detector, one page at a time, but it would be cumbersome.
Wouldn’t it be great if we could train the classifier on a whole dataset at once? We can! On the dataset page locate the
wrench icon to the right of new pipeline but to the left of it’s eye icon. Clicking the wrench will take us to the training
page:

To start, click Classifier on the the top right. This will train a classifier on the entire dataset, or on multiple datasets at
once. Check all the datasets we wish to train on and click Create Transformations. Wait for the process to end, then
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Fig. 8.8: Tile with only Octopi

Fig. 8.9: Tile with Carrot & Basic Selection
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Fig. 8.10: Running a pipeline on the entire dataset

Fig. 8.11: Training Page
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check the right center column. It is a list of all of the images the pipeline will train over. Now click Train. Training
the classifier may take five or more minutes. Don’t use the inspector until training is complete.

It’s the moment of truth, time to test the new_pipeline on our dataset. Open to the dataset page and run the pipeline
as we did before. Congratulations! We ran our first pipeline on our first dataset. Note that we did not have sufficient
training data from this dataset to properly train the classifier. If you find yourself in this situation in the future, try
adding data from similar datasets to boost results. Find the performance statistics on the line directly above the dataset.

This is the breakdown of those statistics: * Hits: Perfect matches. The percentage of labels that were detected and
correctly classified. On the dataset GUI hit tiles are green. * Wrong: Percent of defects that were caught by the
detector but misclassified. On the GUI these tiles are yellow. * Misses (Complete Misses): Percent of labels that do
not map to a single defect (percent of labels that are not covered by a defect at all). If two labels are covered by one
defect one of them is counted a miss. If a label does not intersect at all with a defect it is counted a complete miss. *
IOU: Intersection over union, a measure of how closely the labels and defects match in area. * FA [False Alarms]: the
number of defects divided by the number of labels.

We can get an overview of the pipeline’s performance on each tile via the wafer GUI’s color coding.

• Green: The pipeline found all of our labels and classified them correctly.

• Yellow: The pipeline found all of our labels but misclassified at least one.

• Red: The pipeline did not detect at least one of our labels.

• Blue: The pipeline found defects on a tile without labels.

• White: The pipeline didn’t find any defects on a tile that does not have any labels.

8.6 Iterative Training by Off-Site Technicians

The following is a suggested method for training quickly, off-site, and integrating the results into a pipeline ready for
client use. It uses one central GPU machine.

1. Choose between three and five wafers from one client that were imaged with the same parameters.

2. Label the first wafer, then export those labels and send to the central GPU machine.

3. Follow the directions above for initial training on the GPU machine.

(a) Run the first evaluations on the remaining 4 wafers.

(b) All of the sample wafers must be labeled if you wish to do quantitative analysis on them.

4. Export the resulting pipeline and send it back to the technicians.

5. Run that pipeline on the next wafer, then correct any errors by adding corrective labels.

6. Export the new labels and send them back to the GPU machine.

7. Load the new labels, generate examples and train.

8. Repeat.

8.7 Reference

8.7.1 Index Page

• To add a defect type, click the defect type row above the delete defect type button. Type in a name for the new
defect type, then click the color box on the left. A dropdown will appear. Select a color from the color map,

36 Chapter 8. AI Analyzer



nSpec® User Manual, Release 0.9

Fig. 8.12: Index Page

then click the plus button. The defect type has been added.

• To remove a defect type, simply click the defect type to remove and then click Delete Defect Type.

• To select all pipelines at once for use, click the all button next to CHOOSE PIPELINE.

8.7.2 Dataset Interface

• To filter results by defect type, select one from the defect types list on the left. Here Basic Selection is selected
and the grid tells us that basic selections were found on three tiles, two of which were false alarms. To stop
filtering by defect type deselect the current defect type by clicking it again.

• We will find pipeline settings on the training page, which is reachable through the wrench icon as we discovered
earlier.

• To take photos of all the labels you’ve added on this dataset, click the camera button in the right column. To
view the pictures click the picture button to it’s left.

• To import labels from a database, click the import labels button beneath the picture button.

• To export the labels you’ve added to this dataset click export labels.

• To run the inspector on a single tile, double click the tile.

8.7.3 Label Image Library

A gallery of pictures of the labels you added to the dataset and then photographed. The color beneath the image
indicates its defect type. Use the dropdown to filter by defect type.
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Fig. 8.13: Dataset Interface

Fig. 8.14: Label Image Library
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8.7.4 Pipeline Comparison

Fig. 8.15: Pipeline Comparison

Use this page to visually compare the performance of your pipelines on different defect types and data sets.

8.7.5 Pipeline Training

Arrive at this page by clicking the wrench button on the dataset page. The rightmost column is responsible for settings
that you can tweak to fit different applications and to improve performance.

• Selectivity:

– Detector Selectivity: Directly changes how selective the detector is. Pushing the slider to the right will
make the detector more likely to find labels and false alarms.

– Minimum Dimension: The minimum size that a potential defect must be before it is considered a defect.
Measured in pixel diameter.

– Iterations: How many times the pipeline looks at training data. Increasing this value will improve the
pipeline but take more time. The detector usually requires 10 loops, the classifier 20,00040,000.

– Generate Settings: Will generating examples overwrite previous generations?

• Class Map: Use this to assign one defect type to another. For example, imagine a client doesn’t differentiate
between octopus downfall and octopus. You can assign octopus downfall to octopus for them by clicking the
dropdown next to octopus downfall and selecting octopus.

• Class Weightings: Use this to change the likelihood that a defect will be classified as one type or another. When
there aren’t many training examples from a defect type it’s a good idea to increase the class weighting of that
defect type. It increases the classifier’s sensitivity to some defect types.
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CHAPTER

TEN

DEFECT CLASSIFIER

10.1 Using the Classifier

The Defect Classifier tool allows the operator to categorize the defects. The Classifier operates on the KLARF output
of a defect scan (which itself operates on the KLARF output of a Device Inspection scan). This allows the Classifier
to present images of each defect (or subset of defects) found during those scans, providing a quick reference to the
operator in charge of classifying the defects.
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Navigation between defects is accomplishing via mouse or the up/down arrow keys. Space key or checking the
“should_scrap_device” checkbox will mark that defect as a ‘device-killer’ defect: one that prohibit the device from
functioning. Finally, typing the number of each classification (or selecting from the dropdown) will set the classifica-
tion of that defect.

When classification is complete, an operator would then use the Save options in File menu. One option saves the
revised Klarf file, the other saves in an XML output format.
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CHAPTER

ELEVEN

ADMINISTRATION

Attention: This section is normally to be executed by Nanotronics Technical Service staff. Please do not under-
take if not specifically directed to do so or you have been trained on the administrative procedures.

11.1 Installation

11.1.1 3rd Party Installs

The first step of nSpec installation prepares the required third party applications and libraries. Note, this step should
only need to be completed once at install time and then only repeated for any updates to 3rd party components (which
occur relatively rarely).

1. Retrieve Minimum Required Installs (available from Technical Service or in the Nanotronics Software Develop-
ment shared folder.

2. Open the folder in Explorer.

3. Install CUDA: run cuda_7.0.28_windows.exe

4. Install Python: run install_everything_python.bat from the Python Installers subfolder

5. Install Labjack: run LabJack-2016-11-09.exe

6. Install the IXXAT drivers: run vci_3_5_1_3826.exe

7. Install AVT software: Vimba_v2.1.1_Windows.exe

(a) Click 3rd Party Applications > Transport Layer Interface, and OK

(b) Click Vimba Application > Camera Demonstration and OK

(c) Click Custom Selection and modify:

• Unselect all Vimba 1394 Transport Layer

• Unselect all Vimba USB Transport Layer

• Unselect all Vimba Camera Link Transport Layer

• Unselect Vimba Viewer for other platforms

• Unselect all start screen and desktop shortcuts

8. Install ProMotion: run ProMotion.exe

9. If a Cognex camera is being used with the nPLACE™ install Cognex In-Sight Wafer ID 4.5.0.exe

10. Install the nSpec development libraries: run nanotronics-libraries-installer-<latest date>.exe
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11. Important: Log out and Log back in again.

11.1.2 Drivers

Install the following drivers as appropriate for the equipment. See Nanotronics Technical Service if there are ques-
tions about what hardware configuration is present. Drivers can be found in the Minimum Required Installs/Drivers
directory. Installation is accomblished by right clicking on the file and selecting Install.

• Dual light controller (for top/bottom lighting configurations): Dual-Light.inf

• Olympus motorized turret: Olympus-turret.inf

and, if Macro is installed,

• Macro inspection: Macro.inf

11.1.3 Configure Cameras

The computer network should be setup such that AVT cameras are connected to an independent gigabit network port.
The Local Area Network and Cognex cameras (if installed) can be used with any port.

After cameras have been installed, confirm which cameras are on which ports and rename the interfaces for easy
indentification:

1. In Windows, go to Network and Sharing Center then click Change adapter settings from the options on the
left side of the window.

2. For all connections in use, name them appropriately: LAN, nSpec AVT, Macro, Cognex, etc.

AVT

1. For any connection supporting AVT cameras, from the Change adapter settings window (reached through
Network and Sharing Center as above, right click on the connection with the AVT camera (nSpec or Macro),
and select Properties.

2. In the Properties window click Configure.

3. Select the Advanced tab. In the property list, make the following changes:

(a) Jumbo Packet = 9014 Bytes

(b) Receive Descriptors = 512

(c) Performance Options > Interrupt Moderation Rate = Extreme

Note: It is important that the gigabit network card used for AVT cameras supports jumbo frames. Lack of jumbo
frames support (as indicated by it not appearing in the property list, will result in poor camera performance).

Cognex

If a Cognex camera is being used with nPLACE™ to read the wafer’s laser scribe, the camera and network should be
setup as follows:

1. Start the Cognex In-Sight Explorer Software. For each Cognex camera to be used, if the camera appears in the
left screen.
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(a) Select the camera from the “In-Sight Network” pane.

(b) Open Sensor -> Network Settings from the toolbar.

(c) Turn off DHCP and enter

• IP: 192.168.70.11 (for the first Cognex, 192.168.70.12 for the second if installed)

• Subnet Mask: 255.255.255.0

(d) Click Apply

If the camera does not appear in In-Sight Explorer, right click on In-sight Sensors and select Add Sensor/Device. If
properly connected, the camera should appear and allow the network settings to be changed.

2. Now, exit In-Sight Explorer and configure the server side of the connection. Return to Network and Sharing
Center, Change Adapter Settings

(a) Right click on the the connection with the Cognex camera(s).

(b) Click Properties

(c) Select Internet Protocol Version 4 (TCP/IPv4) and click Properties

(d) Select Use the Following IP Address and enter

• IP: 192.168.70.1

• Subnet Mask: 255.255.255.0

The remaining fields can be left blank.

(e) Click OK.

3. Restart In-Sight Explorer and make sure that the camera is still connected.

11.1.4 Install nSpec

Installation of nSpec itself is quite simple:

1. Retrieve the latest installer.

2. Double click the installer and follow the prompts.

3. Carefully observe the output and verify that nInstall completed correctly (with an exit code of zero).

The installer will:

• Create a backup of your Program Data folder (if a previous install exists)

• Install the nSpec software

• Upgrade databases

• Create desktop icons

• Register with the Windows application manager so that the Windows uninstall will remove the program.

Multiple versions of nSpec can be installed at a time. However, it will require manipulation of Program Data folders
to switch between them.

The first time nSpec is installed one additional step needs to be taken - configuring shared folders.

1. Establish folder sharing for the Scans folder

(a) Right click the C:Scans folder and select Properties

(b) Select the Sharing tab.
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(c) Click on the Advanced Sharing tab.

(d) Check the Share this folder box.

(e) Click the Permissions button.

(f) In the Permissions for Everyone box, check the box to allow Full Control

(g) Select OK in this window and the next.

(h) Click the Close buttom to close the properties dialog.

2. Establish folder sharing for the ProgramData folder

(a) Right click on the C:ProgramData folder and select Properties

(b) Repeat steps 1a-h from the Scans folder instructions.

11.1.5 Verify Installation

1. Check C:Nanotronics Imaging<Version#>/Timestamp_<version#>.txt and verify that no errors were reported.

2. Start nSPEC™ and observe start-up and hardware initialization.

11.2 Calibration

11.3 Configuration
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CHAPTER

TWELVE

TROUBLESHOOTING

The following table contains troubleshooting information for the nSpec® system.

Note: The first step in troubleshooting most issues would be to restart the nSpec software.

Symptom or Error Error Try this. . .
Can’t update image
database

Scans folder is full. [Move some scan data to an
external drive or network
folder.]

Stage makes whining sound with X,Y or
Z movement

Contact Nanotronics
Imaging.

Scanning options are greyed
out • Check the user

level.
• Verify that the autoloader has

initialized.

LabJack fails to
initialize

The LabJack has a USB connection from the nSpec unit
to the PC. Unplug from and replug to the PC, or try
switching USB
ports.

Autoloader won’t power
up

Make sure the E-Stop is not depressed and press
the Reset switch on the left side of the
loader.

Weak
vacuum • Check for leaks or kinks in vacuum line or

fitting
• Check wafer angle or

alignment
• Clean the stage and/or end effector with

isopropyl alcohol

The end-effector (stage or aligner)
is occupied

Turn off vacuum and manually remove the wafer from
the end-effector (stage or
aligner).
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CHAPTER

THIRTEEN

REVISION HISTORY

Table 13.1: Revision History
Version Date Description
0.9.0.1295 10/05/12 Document version current with software build 0.9.0.1295
0.9.0.12139 10/05/12 Document version current with software build 0.9.0.12139
0.9.0.12333 12/27/12 Document version current with software build 0.9.0.12333. Template created,

formatting updated. Instructions and figures updated to reflect current software.
0.9.0.12341 01/30/13 Updated analyzer parameter tables; added Appendix with explanation of csv and

xml files; added installation and calibration information.
0.9.0.13288 10/31/13 Updated window menus to current build in Chapters 1 and 2, incorporated some

new functionality, updated system improvements.
0.9.0.14165 08/11/14 Updated to include basic Pattern Editor instructions
0.9.0.14172 10/17/14 Updated menu items and removed obsolete sections

04/07/15 Added information about vacuum switches and sensors; added troubleshooting
suggestions

04/13/14 Removed obsolete sections
0.9.0.14236 05/13/15 Added Golden Die Utility; updated Die Yield parameters

08/26/15 Removed calibration and OASIS configuration procedures
0.9.0.1609002 09/18/16 Added Macro Inspection
0.9.0.1706002 06/26/17 Converted to new generation method. Numerous updates.
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